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Getting Started 
Primary FINAID Screens: 
 Main screen - Create and manage files, initialize assumptions, view list of prospective resident records, and 

create or select individual records for editing. 
 Prospect screen - Enter information for a specific prospective resident and generate reports. 

 
Setting Up a Community File Group: 
1. Create a new file group by selecting New from the File menu on the Main screen.  Details 
2. Enter community and economic assumptions by selecting each item from the Assumptions menu on the Main 

screen.  Details 
3. Establish community admission criteria.  Details 
 
Evaluating Prospective Residents: 
1. Open the desired file group by selecting Open from the File menu on the Main screen.  Details 
2. Create a new prospective resident record by clicking the New button on the Main screen.  Details 
3. Enter prospective resident information on the Prospect screen.  Details 
4. Generate the summary report.  Details 
5. Interpret the results in accordance with community admission criteria.  Details 
 
See also: What Is FINAID 
 

What Is FINAID? 
FINAID assists retirement communities in evaluating the financial condition of prospective residents prior to their 
entry into the community.  By using FINAID, a community can implement an objective and consistent financial 
screening process that meets the operating goals and philosophy of the community. 
 
FINAID projects income for prospective residents based on their financial assets and income sources and compares 
this revenue to projected expenses such as monthly fees, personal expenses, and income taxes.  Actuarial tables 
projecting the length of time residents will live in each care level can be tailored to reflect individual community 
experience.  Alternatively, FINAID can use proprietary standard CCRC actuarial tables which are based on selected 
experience from the A.V. Powell & Associates database (over 700,000 lifeyears of data). 
 
Using FINAID is straightforward: 
 Enter information about the community, such as contract types, fees, and economic assumptions. 
 Enter information about a prospective resident, such as gender, age, income, and expenses. 
 Generate a report showing the expected subsidy over the applicant's lifetime. 
 Interpret the report in accordance with specific community admission guidelines. 

 
See also: Getting Started, Establishing Admission Guidelines, Summary Report, Interpreting Results 
 

Establishing Admission Guidelines 
All retirement communities face a financial aid risk on behalf of their residents, whether they actively seek to accept a 
number of residents who might need aid or try to minimize their potential financial aid requirements. For those that 
accept residents needing aid, the risk is obvious. For those that try to minimize the aid, the risk exists because it’s 
rare that a resident would be asked to leave a facility as a result of depleting financial resources through no fault of 
her/his own. 
 
In order to manage this risk, we recommend that management develop clear financial admission criteria that are 
consistent with the organization’s financial capabilities and implement procedures for monitoring and measuring the 
financial aid obligations. There are two components to measuring financial aid obligations: (1) using objective 
financial admission criteria that matches, or limits, the annual increase in financial aid obligations for new residents to 
the organization’s financial aid budget, and (2) regularly quantifying the financial aid obligations that exist for current 
residents. 
 
FINAID can be used to assist with implementing component (a) management of financial aid liability for new entrants. 
AV Powell & Associates also provides consulting services to assist with component (b) by quantifying the financial aid 
liability for current residents and comparing it to benevolence funds and future expected contributions for 
benevolence. Contact AV Powell or Kathie Harris to obtain a fee quote for these services. 
 
The financial criteria for acceptance or rejection of a new resident should be based on the community’s philosophy 
and goals regarding financial aid. In particular, the criteria must reflect the community’s ability to fund the potential aid 
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associated with a new resident. A community with limited or no financial aid resources will necessarily have more 
restrictive screening policies than a community that intends to accept residents with expected subsidy needs. 
 
If a community has limited resources to provide financial aid, the admission policies are straightforward: accept those 
residents who are projected to require no or minimal financial aid. 
 
On the other hand, a community with sufficient financial resources to provide aid will typically hold financial aid 
endowment funds and conduct annual fundraising. These resources must be allocated between obligations to current 
residents and the increase in financial aid liabilities (obligations) for new residents. The measurement criterion is the 
increase in financial aid liabilities because a new resident may present a need for aid sometime in the future instead 
of in the current year. If we assume that aid requirements for current residents have been properly valued and the 
community holds reserves to cover that liability, then the amount of aid to be given for new entrants depends on the 
budgeted contributions and amount of financial aid reserve surplus to be distributed for current year. FINAID provides 
information that allows management to quantify the amount of the increase in financial aid liabilities at the time new 
residents are accepted. 
 
An example of such a policy may make this situation clearer. Assume that an organization raises $400,000 annually 
in funds designated for financial aid and holds financial aid reserves of $7,500,000. If the valuation of financial aid 
liabilities for current residents is $5,000,000, the organization has a surplus equal to $2,500,000. If management 
implements a policy that allocates $350,000 of the annual fundraising and $250,000 from the reserve surplus, this 
means the organization has decided to fund up to $600,000 for the increase in annual financial aid obligations in the 
current year. The remaining $50,000 from fundraising would be added to the financial aid reserves and potentially 
allocated to a future year.  
 
The practical application is that the organization will accept new residents whose expected financial aid obligations 
(present value of subsidy) accumulates to $600,000. Since actual experience may vary from the assumptions used in 
the calculation, we recommend that a contingency factor be applied to the annual funding threshold. Our rule-of-
thumb for this contingency factor is 15%, so for the $600,000 annual funding, the threshold would be reduced to 
$510,000.  The number of residents admitted with financial aid needs would depend on the individuals’ needs.  The 
needs of two residents could accumulate to $510,000, or the needs of ten residents could accumulate to $510,000. 
 
See also: Interpreting Results, Summary Report, Qualification Guidelines 
 

About A.V. Powell & Associates LLC 
A.V. Powell & Associates provides customized, actuarially based strategies to address the issues and concerns of 
Continuing Care Retirement Communities, Assisted Living Facilities, and Nursing Care Facilities.  Over 300 
communities in 39 states and Korea have selected A.V. Powell & Associates as their actuarial consulting partner. 
 

 

5-9 Clients1-4 Clients 10+ Clients
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We make the following commitments to you: 
 AVP consultants are specialists in the CCRC industry and will continue to place the highest emphasis on 

providing quality actuarial services and software. 
 AVP consultants are active in professional and industry activities, always staying on the leading edge of actuarial 

innovation. 
 AVP has proven stability.  AVP will be around to back you up when you need it. 
 AVP will maintain an effective support network to serve you.  Our support group includes all the AVP consultants, 

facilitating better communication and on-going maintenance consistent with our high standards of quality. 
 AVP has a unique information technology development team, including practicing actuaries, consulting 

accountants, and programming professionals, representing an unparalleled blend of diverse expertise and many 
years of application development experience. We promise to maintain this depth in our development team. 

 
We at AVP are committed to actuarial software and to you - our users. 
 
See also: Support 
 

Creating and Managing File Groups 
The File menu on the Main screen contains items for managing file groups: 
 

Open Opens an existing file group. 
New Creates a new file group.  A file group is 

identified by its community code (three alpha 
characters) and file group code (one 
alphanumeric character). 

Copy Makes a copy of the currently open file group 
and gives it a different community code and/or 
file group code. 

Delete Deletes the currently open file group. 
Data Directory Selects the directory where FINAID stores data 

files.  May be located on your PC or on a server. 
 

See also: File System, Main Screen Options 
 

Creating and Managing Prospect Records 
The Main screen shows a list of existing records for the open file group.   Four buttons manage the records: 
 

Edit View an existing record. 
New Create a new record. 
Copy Copy an existing record to a new record. 
Delete Delete an existing record. 
 
The Options menu on the Main screen contains two methods of sorting the list of records: 
 

Sort by Name Show in alphabetical order. 
Sort by Record ID Show in numerical order. 

 

See also: Entering Prospect Information, Generating Reports, File System 
 

Entering Community and Economic Assumptions 
Community and economic assumptions are accessed from the Assumptions menu on the Main screen.  
Assumptions apply to all prospective resident calculations for the open file group. 
 
Community Name 
Care Levels and Unit Types 
Contracts 
Entry Fee Schedules 
Monthly Fee Schedules 

 
Inflation and Interest Rate Assumptions 
Disposable Income Assumptions 
Federal and State Tax Tables 
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Spend-Down and Medicaid Assumptions 
Actuarial Decrement Assumptions 
Qualification Guidelines 
 
Print Assumptions 
 

Entering Prospect Information 
Prospective resident information is entered in five grids on the Prospect screen: 
 

1. General Information 
2. Demographics and Entry Fees 
3. Monthly Expenses 
4. Long Term Care Insurance 
5. Assets and Income 
 
See also: Prospect Screen Edit Menu, Saving Resident Data, Printing Resident Data, Creating and Managing 
Prospect Records 
 

Generating Reports 
Buttons on the Prospect screen generate reports: 
 

Summary Generates a report summarizing the results.  The report 
can optionally include a second page containing the 
prospective resident information.  See note 1. 

All Iterations Generates a report showing information for all iterations 
and all years.  See note 2. 

Detail Generates a report showing year-by-year information 
about one iteration selected by the Iter # control.  See 
note 2. 

Notes: 
1) From the Options menu, select Include Prospect Information in Summary Report. 
2) From the Options menu, select Enable Diagnostic Reports. 
 
See also: Prospect Screen Options 
 

Interpreting Results 
The criteria for accepting or rejecting prospective residents should be based on each community's philosophy and 
goals regarding financial aid. In particular, the criteria must reflect the community’s ability to fund current and future 
financial aid. A community with limited or no financial aid resources will necessarily have more restrictive screening 
policies than a community that intends to accept residents with expected subsidy needs. 
 
On the Summary report, the average value for the present value of subsidy represents the amount to fund at the time 
of admission in order to cover the expected subsidy needs for that resident. If this amount were funded for all 
residents with projected subsidy needs, the fund and its future earnings would be expected to cover the subsidy 
requirements. However, due to possible variations in actual experience, there is a chance that additional funding 
would be required or that the funding amounts would exceed actual needs.  
 
In order to quantify the risk of depleting the financial aid funds, the model provides additional information about the 
distribution of funding requirements for an individual. The 50th percentile results for the present value of subsidy 
represents the amount of funding associated with a less than 50% chance that the resident’s actual aid will exceed 
that value. The 75th percentile results for the present value of subsidy represents the amount of funding associated 
with a less than 25% chance that the resident’s actual aid will exceed that value. The 95th percentile results for the 
present value of subsidy represents the amount of funding associated with a less than 5% chance that the resident’s 
actual aid will exceed that value. 
 
It should be noted that when funding aid for multiple residents, the difference between the 50th percentile and the 75th 
and 95th percentiles may be less than for a single resident. 
 
The results of FINAID can be used to assist a community with implementing its financial screening policies. For 
example, if a community wishes to limit its financial aid obligation to the greatest extent possible, it would accept only 
residents who are projected to have less than a 5% chance of receiving aid during their lifetimes. This means that the 
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FINAID results for the resident must show $0 present value of subsidy for the 50th percentile, the 75th percentile, and 
the 95th percentile in order to meet that community’s financial screening criteria. 
 
On the other hand, if a community wishes to provide some aid, it can use the average present value of subsidy 
results to accumulate aid for admission until the annual budgets are met. It’s important to realize that with this funding 
approach not all aid occurs in the year of admission and that accepting a resident with projected subsidy needs may 
mean providing aid several years later. Therefore, if a community has a $500,000 annual budget for the increase in 
financial aid obligations, it can accept residents whose average present value of subsidy results sum to $500,000. 
This could be two residents if both have an average present value of subsidy equal to $250,000. Or it could be 20 
residents whose average present value of subsidy equals $25,000 each. 
 
See also: Establishing Admission Guidelines, Summary Report 
 

Community Name 
Community Name is accessed from the Assumptions menu on the Main screen. 
 
Enter the community name as it should appear on reports. 
 
See also:  Entering Community and Economic Assumptions 
 

Care Levels and Unit Types 
Care Levels and Unit Types is accessed from the Assumptions menu on the Main screen. 
 
Care Levels: 

Three care levels must be defined. 
 

Code 
Generally, the codes can be left at the default of 100 for independent living, 300 for assisted living, and 500 for 
nursing care. 
 
Description 
The descriptions can be modified to change the name of the care level, but the intent must remain the same.  For 
example, the name "Independent Living" can be changed, but the care level is still for the most independent 
residents. 
 
Abbreviation 
The abbreviation should be a three-letter abbreviation of the description.  It is used for display on some assumption 
input screens. 
 

Unit Types: 
Unit types are generally set up based on the fee schedule.  Sometimes unit types are modeled together using the 
same name and number, particularly if the fees are similar and there are not very many units of a specific type.  An 
unlimited number of unit types is allowed, but a large number may add complexity for the user. 

 
Code 
The unit type code is related to the care level code.  A unit is assumed to be in a certain level of care based on its 
code. 
For example, if the first care level code is 100 and the second care level code is 300, then unit types 101 through 
299 would be in the first care level.  The unit type code is greater than its care level code but less than the next care 
level code.  New unit type codes can be inserted and deleted using the Edit menu.  Unit type codes are sorted into 
ascending order when saved. 
 
Description 
Descriptions are user-specified. 
 

See also:  Entering Community and Economic Assumptions 
 

Contracts 
Contracts is accessed from the Assumptions menu on the Main screen. 
 
Code 
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A contract code should be set up for each contract type offered to new entrants.  Entrance fees and monthly fees are 
entered for each contract code on another screen, so each fee schedule should have its own contract code.  Use 
Edit menu to insert or delete contracts.  An unlimited number of contracts is allowed, but a large number may add 
complexity for the user. 
 
Description 
Enter a brief description, such as "Lifecare" or "Fee-for-service: 90% refundable". 
 
Min Refund % On Perm Transfer 
This field is for contracts that provide a refund when the resident transfers to assisted living or nursing care.  Enter 
the minimum percentage of entrance fee paid as a refund (if the refund grades down over time to 50%, enter 50).  
FINAID will calculate a lump-sum amount to add to projected assets when the last person on the contract leaves 
independent living for assisted living or nursing care.  The lump-sum amount is equal to the refund % times the total 
entrance fee for the applicant.  (1st person plus 2nd person entrance fee, for ILU entrants.)  See Refunds for 
additional information on handling refund proceeds for FINAID calculations. 
 
Contractual Fees - Perm Year Limit and Contractual Fees - Perm Levels Limit 
There are two columns related to limits on contractual fees.  This feature relates to contracts that provide for different 
fees in assisted living or nursing care depending upon the number of days utilized.  For example, the contract may 
require a different fee during the first two years (or 730 days) of health care than during subsequent days of health 
care.  In this case, select 2 Year as the year-limit.  The Monthly Fees screen will allow input of different fees during 
the contractual period and after the contractual period for all Year Limits except lifetime. 
 
The Levels Limit is used to specify whether the contractual limit applies to time in assisted living and nursing care 
combined, assisted living and nursing care each, assisted living only, or nursing care only.  If ALU+NCU combined, a 
2-year limit would mean two years total in either one or both.  If ALU+NCU each, a 2-year limit would mean up to four 
years total. 
 
IMPORTANT NOTES: 
 If the fees after permanent transfer to assisted living or nursing care do not vary based on the number of days, 

use Lifetime for the Year-Limit and NA for the Levels-Limit. 
 If the fees are different for temporary versus permanent days, code the contract to reflect the permanent day 

payments. 
 If the permanent day payments are different for a period of less than one year, code the contract as if all the days 

are paid at the higher rate. 
 
See also:  Entering Community and Economic Assumptions 
 

Entry Fee Schedules 
Entry Fee Schedules is accessed from the Assumptions menu on the Main screen. 
 
Entry fee schedules can be set up in FINAID for each contract.  If multiple contracts have the same fees, edit one 
contract, save it, then select the next contract.  Click on Copy From to select the contract to copy to the current 
contract. 
 
The Insert Entry/Monthly Fees button on the Prospect screen will load the entry fees from these schedules.  
Alternatively, users may prefer to input entrance fees on the Prospect screen for each applicant, in which case these 
schedules may be left blank. 
 
The fees on the Prospect screen (populated by Insert Entry/Monthly Fees or entered manually) are used in the 
calculations. 
 
See also: Contracts, Subsidy at Entry, Entering Community and Economic Assumptions 
 

Monthly Fee Schedules 
Monthly Fee Schedules is accessed from the Assumptions menu on the Main screen. 
 
Monthly fee schedules can be set up in FINAID for each contract type.  If the contract allows for both a contractual 
period and a non-contractual period, then fees must be entered in both sections.  Input is not allowed in the non-
contractual fee section unless the contract is set up with a limit on the contractual fees. 
 
If multiple contracts have the same fees, edit one contract, Save it, then select the next contract.  Click Copy From to 
select the contract with the fees to be copied to the current contract. 
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The Insert Entry/Monthly Fees button on the Prospect screen can be used to load monthly fees from these 
schedules.  Alternatively, users may prefer to input monthly fees on the Prospect screen for each applicant, in which 
case the Monthly Fee schedules can be left blank.  The fees on the Prospect screen (populated by Insert 
Entry/Monthly Fees or entered manually) are used in the calculations. 
 
The following rules explain how the Single and Add'l Per columns are used during each simulation year: 
 If a person is a single or is the only survivor of a couple, the Single column is used. 
 For a couple with both alive in the same level of care, person 1 uses the Single column and person 2 uses the 

Add'l Per column. 
 For a couple with both alive and not in the same care level, the person in the lower care level uses the Single 

column and the person in the higher care level uses the Add'l Per column. 
 
See also: Contracts, Entering Community and Economic Assumptions 
 

Inflation and Interest Rate Assumptions 
Inflation and Interest Rate Assumptions is accessed from the Assumptions menu on the Main screen. 
 
Inflation rates for the projection period are specified on this screen.  These rates can vary during the first five years 
and will remain level thereafter. 
 
Fee Inflation 
Fee inflation can vary by level of care.  ILU fee inflation will be applied to independent living monthly fees.  ALU fee 
inflation will be applied to assisted living monthly fees.  NCU fee inflation will be applied to nursing care monthly fees.  
The Yr 1 inflation should be zero if current fees are entered in Monthly Fees or on the Prospect screen. 
 
Personal Expenses Inflation 
Personal expenses inflation will be applied to all personal expenses entered on the Prospect screen.  If current year 
dollars are input, the Yr 1 inflation should be zero. 
 
Medicaid Inflation 
Medicaid inflation will be applied to the Medicaid daily rate.  The Yr 1 inflation should be zero if current year dollars 
are input. 
 
General Inflation 
General inflation will be applied to all income and asset items that have a check in the inflation adjustment column on 
the Prospect screen.  For example, Social Security income and investments in stock are usually inflation-adjusted, so 
they would be increased at the general inflation rate.  If current year dollars are input, the Yr 1 inflation should be 
zero. 
 
Present Value Discount Rate 
The present value discount rate is used to calculate the present value of projected subsidy over the resident's 
lifetime.  This rate should reflect the investment earnings rate on the community's benevolent funds.  If a positive 
(>0%) interest rate is entered in Yr 1, then the present value calculation treats net disbursements as if they are made 
at end of year. If a 0% interest rate is entered in Yr 1, then the present value calculation treats net disbursements as if 
they are made at beginning of year; yielding a slightly larger, more conservative subsidy estimate. 
 
See also:  Entering Community and Economic Assumptions 
 

Disposable Income Assumptions 
Disposable Income Assumptions is accessed from the Assumptions menu on the Main screen. 
 
The distribution and earnings rates for an applicant's disposable income is defined on this screen.  A portion of 
disposable income can be specified as "spend immediately," which means it will not be added to assets.  The 
remainder of the disposable income can be invested in four possible categories:  savings, stocks/equities, bonds 
taxable, or bonds non-taxable.  Different earnings rates can be entered for each category and should reflect market 
rates of return for different types of investments.  Assets can be distributed as desired among the spend or invest 
categories, but the total distribution must add to 100%. 
 
Disposable income can be projected from two situations.  The first is when a lump-sum adjustment is made, such as 
when an asset is liquidated to pay the entrance fee, or when life insurance proceeds are received, or when refund 
proceeds are received.  In these situations, the portion allocated to "spend immediately" is ignored, and the remaining 
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categories are pro-rated to equal 100%.  If "spend immediately" is set to 100%, disposable income will all go to 
savings if a lump-sum adjustment is projected. 
 
The second situation that generates disposable income is when residents' income is projected to exceed their 
expenses in a year.  In this situation, disposable income will be distributed according to the percentages defined on 
this screen. 
 
The detail report includes a table of assets in each projection year.  The first four rows of the table reflect the 
disposable income balances for each category.  If projected income is less than expenses, assets will be drawn down 
in the order of the asset rows, starting with Disposable Income (DI) Savings. 
 
See also:  Entering Community and Economic Assumptions 
 

Federal and State Tax Tables 
Federal and State Tax Tables is accessed from the Assumptions menu on the Main screen. 
 
FINAID calculates income subject to taxation, which excludes non-taxable income and 15% of Social Security 
income.  FINAID also reduces taxable income by an amount interpolated from the appropriate Single or Joint column 
in the Federal Deductions Table.  The default values in the table are based on the over age-65 standard amounts 
from the 2002 IRS tax tables and can be modified by the user.  In addition, all monthly fees paid while in assisted 
living and nursing care are assumed to be qualified medical expenses deductible for income tax purposes.  
 
The Federal Tax tables are used to calculate federal taxes, based on taxable income.  The default federal tax tables 
in FINAID are based on 2002 tax rates and can be modified by the user.  FINAID will use the Single Tax Table if only 
one prospective resident is projected to be alive, and the Joint Tax Table if two prospective residents are projected to 
be alive.  FINAID will look for the income level just below the taxable income.  Taxes will be calculated as the 
constant amount plus the increment percent times the taxable income less income level. 
 
State taxes are calculated in the same manner as federal taxes, but using the State Tax tables.  The default state tax 
tables contain a flat 5% tax.  These tables must be customized by the user for each community. 
 
See also:  Entering Community and Economic Assumptions 
 

Spend-Down and Medicaid Assumptions 
Spend-Down and Medicaid Assumptions is accessed from the Assumptions menu on the Main screen. 
 
If the community participates in Medicaid, the payments from Medicaid can offset all or part of a prospective 
resident's projected subsidy in assisted living and/or nursing care.  Medicaid and community-specific spend-down 
thresholds affect eligibility for assistance from Medicaid and the community. 
 
A per diem rate must be entered in the Medicaid Daily Rate field for Medicaid reimbursement to be considered in the 
calculations.  The maximum assets that a resident can hold and still be eligible for Medicaid must be entered in the 
Medicaid Maximum Assets field.  FINAID also has fields for community-specific maximum assets (spend-down 
threshold) for each level of care to reflect the current practices for benevolence. 
 
If the projected income is less than projected expenses, the prospect's assets will be reduced to the spend-down 
threshold.  The spend-down threshold is the larger of the Community Maximum Assets or Medicaid Maximum Assets 
for the lowest occupied care level.  For example, if one person of a couple is in Assisted Living and the other person 
is in Nursing Care, the spend-down threshold will be the larger of the Community Maximum Assets or Medicaid 
Maximum Assets from the Assisted Living column.  If either person is in Independent Living, the spend-down 
threshold will be the Community Maximum Assets value from the Independent Living column. 
 
A Medicaid benefit is not possible for any of the following situations: 
 Single and in Independent Living. 
 Single and the Community Maximum Assets value is greater than Medicaid Maximum Assets. 
 Both people are in Independent Living. 
 One person is in Independent Living and the Community Maximum Assets value for Independent Living is 

greater than zero. 
 Neither person is in Independent Living and the Community Maximum Assets value is greater than Medicaid 

Maximum Assets for the lowest occupied care level. 
 
In all other situations, Medicaid reimbursement is possible. 
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If Medicaid is possible, the maximum Medicaid benefit will be the sum of the Medicaid Daily Rate values from the 
occupied care levels.  When assets have been spent down to the appropriate threshold (i.e. no assets are available 
to pay expenses), a subsidy is projected.  If the Medicaid Daily Rate is greater than zero, FINAID will adjust the 
subsidy to reflect Medicaid income.  If the Medicaid rate is greater than or equal to the fees due, then the projected 
subsidy is set to zero because Medicaid will pay only the difference between resident income and expenses (fees 
due).  If the Medicaid rate is less than fees due plus personal expenses, the projected subsidy will be the difference 
between the two amounts.  If this difference, which is often referred to as the Medicaid contractual allowance, should 
not be projected as a subsidy, then the Medicaid Daily Rate needs to be changed to equal the highest possible 
monthly fee (converted to a daily per diem) for that care level.  This convention will result in a zero projected subsidy 
for those residents who qualify for Medicaid reimbursements. 
 
See also:  Entering Community and Economic Assumptions 
 

Actuarial Decrement Assumptions 
Actuarial Decrement Assumptions is accessed from the Assumptions menu on the Main screen. 
 
The longevity (mortality), move-out (withdrawal), and health care usage (morbidity) rate tables are selected on this 
screen.  If A.V. Powell & Associates has calculated community-specific tables to reflect individual community 
experience, these will be provided.  Otherwise, proprietary CCRC actuarial decrement assumptions that were derived 
from experience in the A.V. Powell & Associates database will be provided. 
 
See also:  Entering Community and Economic Assumptions 
 

Printing Community and Economic Assumptions 
Select Print Assumptions from the Assumptions menu on the main screen.  Choose which assumptions to print. 
 
See also:  Entering Community and Economic Assumptions 
 

General Information 
General information about a prospective resident is entered on the Prospect screen. 
 
Record ID 
The ID number defaults to the next highest unused number, but can be changed to any unused number.  If the ID 
number is changed on an existing record, it will be saved under the new number and the record under the old number 
will be gone.   
 
Include 2nd Person 
Check here if the record is for a couple.  Uncheck if prospective resident is single. 
 
Contract Type 
Choose the contract from the drop box. 
 
Unit Type at Entry 
Choose the unit type from the drop box. 
 
Expected Entry Date 
Enter the expected date that the prospective resident will move into the community.  This date will be used along with 
the date of birth to calculate age at entry.  FINAID projections are annual starting with year one, not based on a 
calendar date.  It is assumed that the values of assets, income, and expenses are current in the first projection year. 
 
Apply LTC Insurance 
When this option is checked, a Long Term Care Insurance grid will open next to the Monthly Expenses grid. 
 
See also: Couples With Different Contract Types, Entering Prospect Information 
 

Demographics and Entry Fees 
Demographics and entry fees for a prospective resident are entered on the Prospect screen.  It does not matter which 
person is person 1 and which person is person 2, as long as data is entered consistently for each person. 
 
Last Name 
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First Name 
 
Gender 
 
Date of Birth 
 
Care Level at Entry 
Choose the care level abbreviation from the drop box.  Couples can enter in two different care levels. 
 
Entry Fee 
Enter the appropriate entry fee for each person based on the desired contract type, unit type and care level.  
Alternatively, use the Insert Entry/Monthly Fees button to fill in the entry fees.  See Subsidy at Entry if any portion of 
the entry fee will be subsidized by the community at the time of move-in. 
 
See also:  Entering Prospect Information 
 

Monthly Expenses 
Monthly expenses, consisting of contractual monthly fees, non-contractual monthly fees, and personal expenses are 
entered on the Prospect screen. 
 
Explanation of Single/Add'l Per Columns 
The following rules determine which monthly fee and personal expense columns are used during each simulation 
year:  
 If a person is a single or is the only survivor of a couple, the Single column is used. 
 For a couple with both alive in the same level of care, person 1 uses the Single column and person 2 uses the 

Add'l Per column. 
 For a couple with both alive and not in the same care level, the person in the lower care level uses the Single 

column and the person in the higher care level uses the Add'l Per column. 
 
Contractual Fees 
Contractual monthly fees are entered for each person based on the desired contract type, unit type, and care level. 
 
Non-Contractual Fees 
Non-contractual monthly fees will be available for input only if the specified contract is defined to require different fees 
after a limited contractual term. 
 
The Insert Entry/Monthly Fees button may be used to fill in the contractual and non-contractual amounts from the 
monthly fee schedules. 
 
Personal Expenses 
Personal expenses are entered in the Monthly Expenses grid beginning in the third row.  Personal expenses can be 
entered in one row or multiple rows.  Personal expenses must be entered as monthly amounts.  They will be 
increased at the personal expense inflation rate in the FINAID projection. 
 
Personal expenses can vary by level of care.  Generally, personal expenses will decline as a resident moves through 
the continuum of care. 
 
Personal expenses should include all non-fee expenses except long-term care insurance premiums, which are 
entered separately in the Long Term Care Insurance grid, and income taxes, which are calculated by FINAID.  Some 
personal expenses to consider include life insurance premiums, prescriptions and other medical costs, meals and 
utilities if not included in monthly fees, travel, and gifts. 
 
See also: Prospect Screen Edit Menu, Entering Prospect Information 
 

Long Term Care Insurance 
Long Term Care insurance data is entered on the Prospect screen.  "Apply LTC Insurance" in the General 
Information grid must be checked to display the LTC input grid.  Enter data in the appropriate column for each person 
who has LTC insurance. 
 
Benefit Period 
The number of years that the long term care benefits will be payable.  Choose the appropriate term from the drop 
down box.  If unlimited, choose Lifetime.  Otherwise, choose the number of years provided. 
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Elimination Period 
The number of days before benefit payments begin.  Typical elimination periods are 30, 60, 90 or 120 days.  Choose 
the appropriate term from the drop down box. 
 
ALU Daily Benefit 
Enter the current daily benefit amount for assisted living care.  Enter zero if the policy does not include assisted living 
benefits. 
 
NCU Daily Benefit 
Enter the current daily benefit amount for nursing care.  Enter zero if the policy does not include nursing care 
benefits. 
 
Inflation Adjusted 
Check if the daily benefits increase with inflation in future years.  Do not check if the daily benefits are level. 
 
Annual Premium 
Enter the current annual premium for the long term care policy.  This amount will be added to total projected 
expenses.  If the resident is projected to be in benefit, FINAID assumes that premiums are waived and the projected 
annual premium expense becomes zero.  In benefit means that long term care insurance benefits are included in 
projected income.  If the benefit period under the LTC policy is limited and the resident is projected to need care 
beyond that period, the income from LTC benefits becomes zero and the premium expense remains at zero 
(coverage has terminated). 
 
Premium Inflation 
Enter an assumed inflation rate to increase annual premiums throughout the projection.  Since this type of insurance 
is relatively new, annual premiums could increase significantly more than other inflation rates.  Enter 5% as "5." 
 
See also:  Entering Prospect Information 
 

Assets and Income 
Assets and income are entered on the Prospect screen. 
 
Assets are liquidated as needed in the order entered.  The first asset row will be used toward the entry fee, continuing 
sequentially as needed.  Therefore, the order of assets is important.  A primary residence that will be sold when the 
resident moves in should be the first asset in the list.  See Prospect Screen Edit Menu for information on how to 
rearrange the rows. 
 
Each column is described below: 
 
Type 
Indicates the type of income or asset. 
 

Predefined Asset Types Predefined Income Types 
Primary Residence Social Security 
Real Estate Pension 
Savings/CD Annuity 
Stocks/Equity Funds IRA/401(k) 
Bonds/Bond Funds Roth IRA 
Life Insurance Alimony 

 

If a prospective resident has an income or asset that does not fit one of the predefined types, use the "Other" or 
"Other (Income Only)" type. 
 
Description 
A brief description can be entered for each item. 
 
Own 
This field indicates the ownership of the income or asset. Valid choices are "J" for joint, "1" for a single person or 
Person 1 of a couple, and "2" for Person 2 of a couple.  Income items such as Social Security or pension must be 
associated with a specific person since these amounts may cease or adjust if that person is projected to die.  Assets 
with joint ownership will continue if one person in a couple is projected to die, but assets with individual ownership will 
only continue at the survivorship percentage. 
 
APR% 
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This field is the annual percentage rate of return on an asset.  The asset balance must be greater than zero to allow 
input in the APR% field.  The APR% is generally entered as an annual amount and the frequency is annual.  If the 
frequency is changed to be monthly or quarterly, the APR% will be recomputed on that basis.  If the income is 
entered, the APR% will be recomputed based on the income and frequency. 
 
Freq 
This field indicates the frequency of the income payments.  Choices are "A" annually, "Q" quarterly, and "M" monthly. 
 
Income 
This field is the income amount paid at the frequency indicated in the Freq field. 
 
Begin 
Indicates the projection year when the income starts.  For example, if a prospective resident will begin receiving 
pension payments one year after move-in, select "2" (second projection year).  If income is already in effect, select 
"1." 
 
Dur 
Indicates the duration of an asset or income amount.  Typically, the duration will be "L" for lifetime.  One exception is 
an annuity, which may have a limited duration remaining on the income.  The remaining number of projection years 
for income payments must be selected if the Annuity type is used.  If the life insurance asset type is selected, the 
duration will be "D" since it is payable on death. 
 
Inf Adj 
Check this box if the asset balance is expected to appreciate in addition to generating income.  The general inflation 
rate will be applied to inflation-adjusted assets. 
 
Tax 
Indicates whether the income is subject to taxation.  If the income is not taxable (such as tax-exempt investments), 
the Tax should be "N".  Social Security items show a tax status of "SS" which indicates that 85% of that income is 
taxable. 
 
Surv % 
Used for couples to indicate the portion of the asset or income that will continue to the other person if the owner is 
projected to die first.  If a pension on Person 1 is $800 while Person 1 is alive, but only $400 if Person 1 is deceased 
and Person 2 is alive, the survivorship percentage should be 50%.  If none of the asset or income will continue, the 
survivorship percentage should be 0%.  For Social Security, the survivorship percentage will be "SS." 
 
See also:  Entering Prospect Information, Refunds, Subsidy at Entry 
 

Summary Report 
The Summary report is generated by the Summary button on the Prospect screen. 
 
The results of the FINAID projection for a prospective resident or couple are shown on a one-page summary report.  
The report can include a second page containing the prospective resident information if Include Prospect 
Information in Summary Report is checked on the Options menu. 
 
Using a stochastic simulation technique, FINAID applies the community's actuarial decrement assumptions to 
generate thousands of iterations of year-by-year care level status.  Each iteration is run through the financial 
calculation logic to determine the annual projected subsidy.  All iterations are combined to provide a distribution of 
projected subsidy for each year.  From these distributions various statistics on the probability of subsidy are derived. 
 
Statistics Table: 

This table shows the arithmetic average and three order statistics: 
Average Average of all iterations (mean) 
50th Percentile 50% of iterations lie below this value (median) 
75th Percentile 75% of iterations lie below this value 
95th Percentile 95% of iterations lie below this value 

 
Total Subsidy 
The total subsidy is the total amount of subsidy required after of all the resident's income and assets are applied 
toward fees and other expenses. 
 
Present Value of Subsidy 
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The present value is based on the specified present value discount rate.  The present value of the subsidy is the 
total subsidy in today's dollars.  It is the amount that should be set aside now to fund the future expected subsidy 
requirements if the prospective resident is admitted to the community. 
 
Projected 1st Year of Subsidy 
The projected 1st year of subsidy is the first projection year that subsidy will be needed.  In calculating this statistic, 
any iterations where no subsidy is projected are excluded (refer to "Probability of subsidy during lifetime" for 
likelihood of receiving subsidy).  "NA" is displayed if all projected iterations show no subsidy, i.e., $0 in aid.  The 
projected year of subsidy may be different at each of the four points reported.  For example, subsidy needs may 
begin sooner at the 95th percentile than at the 75th percentile, because the iterations with the greatest subsidies 
may have resulted from earlier and more extensive health care utilization projections.  Alternatively, subsidy needs 
may begin later at the 95th percentile than the 75th percentile, because the iterations with the greatest subsidies 
may have resulted from longer lifetimes. 
 
Expected Lifetime 
Expected lifetimes are also shown on the summary report at each of the four statistical values. For couples, this 
number is based on the last survivor's length of stay in the community.  Some financial aid managers like to 
compare the first projected year of subsidy to the expected lifetime to assess the likelihood that subsidy will be 
required.  A better measure of this risk is the "Probability of subsidy during lifetime" statistic. 

 
ALERT STATUS: 
The alert status provides a quick indication of the likelihood that the resident meets the community's financial 
screening criteria as set up on the Qualification Guidelines screen. 
 
Probability of subsidy during lifetime: 

FINAID computes the overall probability that subsidy will be required during the prospective resident's lifetime.  This 
is the percentage of the simulation iterations that result in a subsidy. 
 

30-Year Projected Results Table: 
Expected subsidy if alive 
Generally this amount will increase throughout the projection period.  
 
Probability of surviving up to year 
This probability will decrease over time until the assumed end of life span at age 115.  For couples, it is the 
probability that at least one member survives.  
 
Expected subsidy in year 
This amount equals the "expected subsidy if alive" in the second column multiplied by the "probability of surviving 
up to year" in the third column.  The sum of expected subsidy if alive for all projection years equals the average 
value for the total subsidy row at the top of this report.  
 
Probability of subsidy up to year 
Generally this probability will increase throughout the projection period. It is the percentage of iterations that result 
in a subsidy for that year, excluding iterations where the prospective resident is not projected to be alive in that 
year.  
 
Cumulative expected subsidy up to year 
This amount is the sum of the "expected subsidy in year" in the fourth column from Year 1 to Year N. If the resident 
is projected to live for more than 30 years, the cumulative sum in Year 30 will be slightly less than the amount that 
is given for the average value in the total subsidy row at the top of this report.  
 
Percentage cumulative subsidy is to total subsidy 
This amount equals the "Cumulative expected subsidy up to year" divided by the "Total Subsidy" average.  
 
"NA" is displayed when the resident is no longer projected to reside in the community. 

 
See also: Interpreting Results, Generating Reports , Qualification Guidelines 
 

All Iterations Report 
The All Iterations report is generated by the All Iterations button on the Prospect screen.  Note that this button 
appears only if Enable Diagnostic Reports is checked on the Options menu. 
 
All Iterations shows a grid of all iterations and all years.  Each row of the grid is an iteration, and the columns are 
projection years.  Each cell contains the subsidy projected for that iteration and year.  Each cell also shows, in 
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brackets, the projected care level for that iteration and year.  The first number in the brackets is the care level for 
Person 1 and the second number in the brackets is the care level for Person 2.  The care levels are "1" for 
independent living, "2" for assisted living, and "3" for nursing care.  If the cell is empty, the prospective resident has 
been projected to die before that year.  The purpose of this report is to look for an iteration to specify for the detail 
report. 
 
See also: Generating Reports 
 

Detail Report 
The Detail report is generated by the Detail button on the Prospect screen.  Note that this button appears only if 
Enable Diagnostic Reports is checked on the Options menu. 
 
Detail is displayed for the iteration selected by the Iter # control.  The report contains a summary page showing 
projection year, care level (CL), projected asset balance, annual expenses, annual income, and subsidy requirements 
(shortfall between income and expense, after assets are exhausted).  Total subsidy for the projected lifetime and the 
present value of total subsidy are also shown. 
 
Subsequent pages of the detail report show detail of assets, income, and expenses for each projection year, for the 
selected iteration.  A table shows the beginning of year asset balances (after inflation is applied) for each asset type.  
The first four items will always be the disposable income funds, and remaining items are shown in the order entered 
on the Prospect screen.  In the first projection year, this table reflects balances after the entrance fee has been paid.  
If assets such as real estate were liquidated and exceed the entrance fee, the excess funds will be in the disposable 
income accounts. 
 
The table also shows other information from the income and asset grid on the Prospect screen.  The last two columns 
of the table are annual income and annual tax free (TF) income.  A line beneath the table shows annual expense 
detail:  fees, personal expenses, long term care insurance premiums, calculated income tax, and a total of all annual 
expenses.  Subsidy is also shown on this line, which is equal to total expense less total income.  If expense is greater 
than income but subsidy is $0, then the shortfall was drawn from assets.  The line below expense detail shows 
annual income detail:  income, long term care insurance benefits, Medicaid benefits, and a total of all annual income.  
Entrance fee refund is also shown on this line. 
 
See also: Generating Reports 
 

Support 
Web Site 

www.avpowell.com 
 

St. Louis Office 
Phone 636.530.1072 or 800.828.6309 
Fax 636.530.1073 
Email kathie.harris@avpowell.com 

 amy.lampo@avpowell.com 
 molly.shaw@avpowell.com 
 donna.kingston@avpowell.com 

 
Atlanta Office 
Phone 404.845.0360 or 800.441.4969 
Fax 404.845.0366 
Email av@avpowell.com 

 mike.hopper@avpowell.com 
 john.valorz@avpowell.com 
 corinne.greene@avpowell.com 
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File System 
FINAID stores all user-created information in two files, XXX#glob.fas and XXX#data.fas, where "XXX" is the 
community code and "#" is the file group code.  These two files are referred to as a file group.  When New is selected 
from the File menu on the Main screen, a file group is created with the specified community code and file group code. 
 
File groups are stored in the FINAID data directory which may be located on your PC or on a server.  The default 
location of the data directory is in the Finaid4 directory.  See Setting the Data Directory for information on how to 
change the location. 
 
You can back up your FINAID data by backing up all files in the FINAID data directory. 
 
Actuarial decrement assumptions files are stored in a directory named "Common" located in the Finaid4 directory.  
Since these files are provided by A.V. Powell & Associates, you do not need to back them up. 
 
See also: Creating and Managing File Groups 
 

Report Viewer 
The Report Viewer uses a Multiple Document Interface to allow multiple reports to be displayed simultaneously.  It 
will remain open until you close it by clicking the "X" in the upper right corner of the window.  Two or more reports can 
be compared, even if they were generated by different file groups. 
 
The menu items are described below: 
 
Print 
Print Send to printer. 
Print to File Create a text file containing the report. 
 
Edit 
Select All Selects all text in report. 
Copy Copies selected text to Windows clipboard. 
 
Options 
Large Font Large font in viewer. 
Medium  Medium font in viewer. 
Small Small font in viewer. 
Status Bar Displays optional information at bottom of viewer. 
  Note: The font size in the viewer does not affect the font size in the printed report. 
 
Windows 

Standard MDI commands.

 17



Index  
 

Monthly Expenses, 12 A.V. Powell & Associates, 4 
Monthly Fee, 8, 12 Actuarial Assumptions, 11 
Monthly Fee,entering on Prospect screen, 12 Admission Guidelines, 3 
Monthly Fee,schedules, 8 Aid (projected), 14 
New file group, 5 All Iterations report, 15 
New prospective resident record, 5 Applicant information, 6 
Non-contractual monthly fee, 8, 12 Asset liquidation, 13 
Non-contractual monthly fee,entering on 

Prospect screen, 12 
Assets and Income, 13 
Assumptions, 5 

Non-contractual monthly fee,schedule, 8 Backing up your data, 17 
Open a file group, 5 Care Levels, 7 
Overview, 3 Community and economic assumptions, 5 
Print Community Assumptions, 11 Community files, 17 
Print Reports, 6 Community Name, 7 
Prospective resident information, 6 Contacting AVP, 16 
Prospective resident record, 5 Contracts, 7, 11 
Report Viewer, 17 Contracts,entering in Community assumptions, 7 
Reports, 6 Contracts,entering on Prospect screen, 11 
Resident Information, 6 Contractual monthly fee, 8, 12 
Spend-down, 10 Contractual monthly fee,entering on Prospect 

screen, 12 Subsidy (projected), 14 
Summary Report, 14 Contractual monthly fee,schedule, 8 
Support Services, 16 Copy a file group, 5 
Tax Tables - Federal and State, 10 Copy a record, 5 
Unit Types, 7 Create a file group, 5 

Create a record, 5  
Delete a file group, 5 
Delete a record, 5 
Demographics and Entry Fees, 11 
Detail report, 16 
Diagnostic Reports, 6 
Disposable Income Assumptions, 9 
Economic assumptions, 5 
Entry Fee, 8, 11 
Entry Fee,entering on Prospect screen, 11 
Entry Fee,schedules, 8 
Establishing Admission Guidelines, 3 
File Group, 17 
File System, 17 
Financial Aid, 14 
General Information, 11 
Generating reports, 6 
Getting Started, 3 
Inflation and interest rate assumptions, 9 
Insert Entry/Monthly Fees, 11, 12 
Interest and inflation rate assumptions, 9 
Interpreting results, 6 
Introducing FINAID, 3 
Liquidate assets, 13 
Long Term Care Insurance, 12 
LTC Data, 12 
Maximum assets, 10 
Medicaid, 10 

 18


	User’s Guide
	A.V. Powell & Associates LLC


